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Important User Information 
 

This documentation, whether, illustrative, printed, “online” or electronic (hereinafter “Documentation”) is intended for use only as 
a learning aid when using Rockwell Automation approved demonstration hardware, software and firmware.  The Documentation 
should only be used as a learning tool by qualified professionals.   
 
The variety of uses for the hardware, software and firmware (hereinafter “Products”) described in this Documentation, mandates 
that those responsible for the application and use of those Products must satisfy themselves that all necessary steps have been 
taken to ensure that each application and actual use meets all performance and safety requirements, including any applicable 
laws, regulations, codes and standards in addition to any applicable technical documents. 
 
In no event will Rockwell Automation, Inc., or any of its affiliate or subsidiary companies (hereinafter “Rockwell Automation”) be 
responsible or liable for any indirect or consequential damages resulting from the use or application of the Products described in 
this Documentation.   Rockwell Automation does not assume responsibility or liability for damages of any kind based on the 
alleged use of, or reliance on, this Documentation. 
 
No patent liability is assumed by Rockwell Automation with respect to use of information, circuits, equipment, or software 
described in the Documentation. 
 
Except as specifically agreed in writing as part of a maintenance or support contract, equipment users are responsible for: 

• properly using, calibrating, operating, monitoring and maintaining all Products consistent with all Rockwell Automation 
or third-party provided instructions, warnings, recommendations and documentation; 

• ensuring that only properly trained personnel use, operate and maintain the Products at all times; 
• staying informed of all Product updates and alerts and implementing all updates and fixes; and 
• all other factors affecting the Products that are outside of the direct control of Rockwell Automation. 

 
Reproduction of the contents of the Documentation, in whole or in part, without written permission of Rockwell Automation is 
prohibited. 
 
Throughout this manual we use the following notes to make you aware of safety considerations: 
 

Identifies information about practices or circumstances 
that can cause an explosion in a hazardous environment, 
which may lead to personal injury or death, property damage, or economic loss. 
 
 

 

Identifies information that is critical for successful application and understanding of the product. 
 

 

 

Identifies information about practices or circumstances that can lead to personal injury or death, property 
damage, or economic loss. Attentions help you: 
• identify a hazard 
• avoid a hazard                                                                                                                                 
• recognize the consequence 

 

 

Labels may be located on or inside the drive to alert people that dangerous voltage may be present. 
 
 
 

 

 

Labels may be located on or inside the drive to alert people that surfaces may be dangerous temperatures. 
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Before you begin 

About this lab 

This lab teaches new or inexperienced users basic FactoryTalk® View Studio for Machine Edition skills needed to create 
FactoryTalk® View Machine Edition applications.  The lab starts with an empty project and shows you how to add application 
content and configure communications to create a working system that can both read and write information from a Logix 
controller.  Building on this foundation, students are next shown how to create reusable graphical displays and configure 
language switching.   

Who should complete this lab 

This lab is intended for new users or users with limited experience using FactoryTalk® View Machine Edition.  The lab’s content 
covers the basic operation of FactoryTalk® View Studio for Machine Edition.  If you are an experienced FactoryTalk® View 
Studio for Machine Edition user or HMI designer, you may be dissatisfied with this lab.  Consider trying our advanced labs if you 
are already experienced with FactoryTalk® View Machine Edition.   

What you will accomplish in this lab 

During this lab, you will accomplish the following major tasks:  

 Create and execute a new FactoryTalk® View Machine Edition application on a PanelView™ Plus terminal 

 Use ‘live’ information from a Logix controller in an HMI application 

 Create and use Global Objects on an existing display 

 Use parameters to create a reusable display 

 Configure an application for language switching 

How the lab is organized 

The lab covers the basics for creating a FactoryTalk® View Machine Edition application, adding content, creating a runtime file, 
downloading and running the application on a PanelView™ Plus terminal.  It further shows how Alarms are configured, how to 
use Global Objects and to perform Language switching:  

 Create, test, and deploy a FactoryTalk® View Machine Edition application  

 Work with alarms 

 Work with Global Objects 

 Import content from an existing application  

 Use parameters to improve design efficiency 

 Create a multi-lingual application with language switching 

Tools & prerequisites 

To complete this lab you must use the following hardware and software:  

 A Microsoft Windows 7 64-bit computer 

 PanelView™ Plus 7 Performance terminal 

 Ethernet connection between computer and PanelView™ Plus terminal 
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 FactoryTalk® View Machine Edition Studio V8.00.00 (CPR9 SR7) 

 FactoryTalk® Services Platform 2.71.00 (CPR9 SR7.1) 

 RSLinx Enterprise v5.71.00 (CPR9 SR7.1) 

 RSLinx Classic v3.70.00 (CPR9 SR7 )  

 Studio 5000 Logix Designer v21 (CPR9 SR5.1) 

 SoftLogix 5800 v21 (CPR9 SR5.1) 

 Microsoft Excel 2010 or newer 

Document conventions 

Throughout this workbook, we have used the following conventions to help guide you through the lab materials.   

This style or symbol: Indicates: 

Words shown in bold italics  
(e.g., RSLogix 5000 or OK) 

Any item or button that you must select, click on, or a menu name from 
which you must choose an option or command.  This will be an actual 
name of an item that you see on your screen or in an example. 

Words shown in bold 
(e.g., Communication Setup) 

This is the name of an item that you see on your screen or in an 
example. 
 

Words shown underlined and enclosed in 
single quotes  
(e.g., ‘Controller1') 

An entry that you must type in the specified field.  This is information that 
you must supply based on your application (e.g., a variable). 

Note:  When you type the text in the field, remember that you do not 
need to type the quotes; simply type the words that are contained within 
them (e.g., Controller1). 

This is sample text. 

 

Text that appears inside of a gray box is supplemental information 
regarding the lab materials or learning goals; the information is not 
required for you to complete the lab exercises.  The supplemental text 
may provide you with helpful hints that can make it easier for you to use 
this product. 

Note: If the mouse button is not specified in the text, you should click the left mouse button.   

FactoryTalk® View Machine Edition 

FactoryTalk® View Machine Edition (ME) is a machine-level HMI product that supports both open and dedicated operator 
interface solutions for monitoring and controlling individual machines or small processes.  It provides a consistent operator 
interface across multiple platforms, including Microsoft Windows CE and 64-bit or 32-bit Microsoft Windows 7, XP, and Vista 
solutions.   
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FactoryTalk® View Machine Edition contains two components:  

 FactoryTalk® View Studio – This is the development environment containing the tools you need for creating all aspects of a 
human-machine interface (HMI), including graphic displays, trends, alarm reporting and real-time animation.  It also provides 
tools for testing individual displays and entire applications.  When development is completed, a run-time (.MER) file is 
created to run on a PanelView™ Plus or personal computer.   

 FactoryTalk® View Machine Edition Station – This is the run-time environment.  FactoryTalk® View Machine Edition 
Station executes the run-time (.MER file) application.  FactoryTalk® View Machine Edition Station is embedded in 
PanelView™ Plus terminals.  Run-time applications may also be executed on a personal computer.  Executing run-time 
applications on a personal computer requires additional software licenses.   

PanelView™ Plus 7 

The PanelView™ Plus are operator interface terminals designed to optimize system development, performance, and efficiency.  
The PanelView™ Plus 7 line of terminals is the latest addition to Rockwell Automation’s versatile family of Allen-Bradley 
PanelView™ operator interface displays for machine level operator terminal applications in industrial environments.  

 

The PanelView™ Plus 7 line extends the portfolio with increased display resolutions while still supporting a known design 
environment – FactoryTalk® View Machine Edition.  Please reference the following tables for more information regarding the 
PanelView™ Plus 7 Performance and the entire PanelView™ Plus 7 family. 
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Creating a ‘Hello World’ Application 

Completing this section requires approximately 20 minutes.   

In this section, you will learn how to:  

 Launch FactoryTalk® View Studio for Machine Edition 

 Create a new project, configure project settings, and add content to the project 

 Run the project on a PanelView™ Plus terminal.   

Creating a FactoryTalk® Machine Edition Application 

1. Select FactoryTalk View Studio from the Start menu.   

 

The New/Open Machine Edition Application window will now appear:  

 

Note that the window may contain additional applications that are not shown in the above picture.   
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2. Click the New tab.   

 

3. In the Application name: field, enter ‘Intro’ 

 

4. Next, click the Create  button.   

After creating the application, FactoryTalk® View Studio for Machine Edition opens the application:  

 

If you are unfamiliar with FactoryTalk® View Studio for Machine Edition, please review the information in the next few 
pages.   
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Exploring FactoryTalk® View Studio for Machine Edition Interface 

The FactoryTalk® View Studio for Machine Edition Application Window is difided into several key elements.   

Application Menu - Used to interact with the application; Open/Close/Create new applications, 
Import/Export information, etc.,  The manu will change context based on what project object is open in the 
Work Pane.   

 

Graphics Toolbar – Provides easy access to tools that are used to manipulate objects on a display (e.g., 
rotate, group, ungroup, etc.).  

 

Objects Toolbar – Provides easy access to objects that are used on displays to create the user interface 
(e.g., Numeric Input, String Display, Momentary Push Button, etc.).   

 

Explorer Pane – Contains all objects related to an application project.  Application objects are then opened 
in the Work Pane.  See more information regarding the portions of the Explorer Pan that will be used in this 
lab below.   

Diagnostic List – Contains status and error messages related to the system application and project.   

 

Work Pane – The work area where project objects are opened for manipulation and modification (e.g., 
displays, the tag database, object property windows, etc.).  

 

Explorer Pane Components 

The following portions of the Explorer Pane will be utilized by this lab.  Information regarding the remaining 
components of this pane can be found in the Help file.   

System – Contains project scope settings such as  
resolution, Security settings, Startup graphic files,  
and Diagnostic information.   

HMI Tags – Contains all tags resident in the memory of  
the HMI server that are therefore not found in the Logix  
Controller project.   

Graphics – Contains all graphic related components in  
the application, including displays, images, and the  
parameter files that can be utilized to reuse displays.   
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Alarms – Contains the application’s alarm configuration  
including triggers and messages.  

RSLinx Enterprise – Contains communication shortcuts  
used by the application.   

 

 

 

 

 

 

 

 

 

 

By default, new projects in FactoryTalk® view Studio for Machine Edition are configured for a PanelView™ Plus 700/1000 
terminal with a 640x480 resolution.  In this lab, the PanelView™ Plus 7 1200 W terminal will be used, therefore, the project 
window size must be changed to match the terminal.   

5. If the window is not already maximized, use the maximize button  in the upper right-hand corner to do so.   

6. Double-click the Project Settings item located in the top System container to open its dialog box.   
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7. Use the drop down list to select PVPlus 7 Standard/Performance 12” Wide (1280x800).   

 

8. Select Execute MER on PanelView Plus 7 Performance. 

 

9. Click OK to accept the window size change.  

The Graphic Display Scaling window will appear:  
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This dialog gives the user the ability to determine which graphic components of the application will scale once the display 
size change has been accepted.  Because this is a new project, leave the settings at default.   

10.  Click OK to continue the scaling process.   

 

11. Click Yes to the following popup which warns that the aspect ratio will change. 

 

12. To view existing displays, expand the Displays container by clicking the expander  from the Explorer Pane 
window.   

 

When a new project is created, FactoryTalk® View Machine Edition will automatically create four default displays, one of 
which is called MAIN, defined as the initial startup display.  This display will be used for the following steps in the lab.  When 
more displays are required, they can be added, as seen in a future section.   

13. Double click on the MAIN display to open it.  

The display will open in the Work Pane of FactoryTalk® View Studio for Machine Edition.   
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A shutdown button is automatically created with each application.  This button is used to shut down the 
application on the runtime device.  When the application is shut down, that runtime device will close 
FactoryTalk® View Machine Edition Station.   
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Adding Content to a Display 

In this section, a simple Text object will be added to the screen.   

1. Select the Text  object, and add a text box to the display by clicking the left mouse button and dragging the 
cursor to the right and down.   

 

 

When you release the mouse button, the Text Properties dialog will open.   

2. Click the Text field and enter ‘Hello World!  This is my Intro application.’ 

 

3. Select 14 from the Size drop down to increase the size of the text. 

 

4. Click the OK button.   
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The display should now look similar to this:  

 

5. Close the display using the File > Close menu item.   

6. When prompted to save MAIN, click the Yes button.   

 

 

Now that an object has been added to the MAIN display, verify that it is configured as the application’s Startup graphic.   

7. To open the Startup dialog, double-click on the Startup item  in the System container.   
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Notice the components that can be configured to execute when the application starts.  Items such as Alarms and 
Information messages can be turned on or off, macros can be executed upon startup, and any display that has been 
created can be specified as the initial graphic.   

Because MAIN is the only display that has been created, it is selected as the initial graphic by default.   

8. Click OK to close the dialog.   

Creating the Runtime Application File 

In order to transfer the application to a PanelView™ Plus terminal, it first must be compiled into a Runtime Application File 
(*.mer).  Follow the steps below to create the runtime file.   

1. Select the Application>Create Runtime Application menu item.   
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Additional Runtime Application Options 

The options available in the Conversion to development application section allow later recovery of the 
design files from the runtime project using the Application Manager. 

Always allow conversion [Default] – The design information is always included with the runtime, so that it 
may be restored from the MER.  The resulting MER requires more terminal memory to store the file. 

Never allow conversion – Design information cannot be recovered from an MER created with this option 
selected.  The MER created requires the least amount of terminal memory. 

Conversion protected by password – When using Application Manager to extract the design information 
from the runtime file, the user will be prompted for the configured password.  The resulting MER requires 
more terminal memory to store the file.   

2. Save the runtime project using the suggested name Intro.mer by clicking the Save button.   

While FactoryTalk® View Studio for Machine Edition is creating the runtime MER file, a progress dialog will appear: 

 

 

The runtime file has been created when the progress bar disappears.   
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Downloading a runtime MER to a PanelView™ Plus terminal 

1. To download the runtime MER to the PanelView™ Plus terminal located at this workstation, first select the Tools 
> Transfer Utility menu item.   

 

The Transfer Utility will open 

 

2. Click the Source File Browse button  to select the runtime MER file to download.   
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This opens the Select File to Download dialog.   

 

Note that the window may contain additional runtime files than those shown in the picture above.   

3. Click on the Intro.mer file to select the project, then click Open.   

 

The Source file is now updated with the Intro.mer directory:  
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4. Double-click the EtherNet, Ethernet driver  to expand the item.   

5. Select the 192.168.1.20, PanelView Plus_7 Performance 1200W item by clicking on it once.   

Note that more devices may be shown in the list than shown in the picture below:   

 

6. To initiate the download process, click the Download button.   

7. If a message stating that the Intro application already exists on the terminal, click Yes to overwrite it.   

A progress dialog will then appear:  

 

When the download process completes, a confirmation dialog is shown.   

 

8. Click the OK button to acknowledge the dialog.   

9. Click the Exit button to close the Transfer Utility.   
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Running an Application on a PanelView™ Plus Terminal 

Use the steps below to load and run the Intro application on the PanelView™ Plus located at this station.   

1. Tap on the PanelView™ Plus screen if the screensaver is active.   

The PanelView™ Plus 7 desktop is now visible.   

 

2. Locate the FTView ME Station icon on the desktop and double tap it to launch FactoryTalk® View ME Station.   

 

3. Press the Load Application [F1] button.   
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4. Select the Intro.MER file from those available from the terminal’s Internal Storage.   

 

5. Press Load [F2] to load the runtime file in to memory.   

 

6. When prompted, press Yes [F7] to overwrite the terminal’s current communication configuration with the 
configuration contained within the Intro.MER file.   
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7. Once successfully loaded, press the Run Application [F2] to start executing the runtime file.   

 

While the terminal is starting the application, an update dialog is displayed.   

 

After the start up process completes, you should see your application’s startup display:  

 

8. Click the Shutdown button to terminate the application.   

Congratulations!   

You have successfully created a FactoryTalk® View Studio for Machine Edition application, added application content, 
created a runtime file, downloaded the runtime file to a terminal and run the application on a PanelView™ Plus terminal.   
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Animating a Display with Control System Data 

Completing this section requires approximately 30 minutes.   

This section will cover:  

 Configuring RSLinx Enterprise Communications for an application 

 Adding ‘Live’ objects to a display 

 Testing an application using the Test Run Application functionality of FactoryTalk® View Studio   

Configuring Communications 

1. Return to the HMI project in FactoryTalk® View Studio and double click the RSLinx Enterprise item to expand.   

 

2. Right-click on the Communication Setup item and select Open, or double click Communication Setup to 
launch the RSLinx Enterprise Configuration Wizard.   

 

Note that this wizard can also be opened by double clicking Communication Setup.   

 



 

27 of 126 

The Configuration Wizard gives a user three options for configuring communications for the application:  

Create a new configuration – Generates an empty communication configuration scheme for the application.  
This selection is enabled by default.  

Copy an existing configuration from a previously created project – Reuses a communication 
configuration from a different application file.  

Copy the configuration that is currently running on this workstation – Copies the communication 
configuration from an application currently hosted by FactoryTalk® View Machine Edition Station located on 
the same workstation.   

3. Select the default Create a new configuration option, and click Finish.   

The Communication Setup dialog will now appear:  

 

Note that the window can be resized or maximized if desired.   

Exploring the Communication Setup dialog window 

The Communication Setup dialog has three main areas:  

Device Shortcuts – A list of shortcuts defined for this application  

Network Path – Displays the network topology pat to the device associated with the selected shortcut, (e.g., 
ControlLogix processor, drive, etc.).  This path is also used to define the network path for a selected shortcut.   

 Design (Local) – Configure the network and device path(s) for the development environment.  This net 
configuration may be different than the production environment in which the application with ultimately run.   

 Runtime (Target) – Configure the network and device path(s) for the production environment.   

 Copy from Design to Runtime button – Used when the Design and Runtime paths will be identical.   

Offline Tag File – Displays the hard drive path to the ACD file associated with the selected shortcut.  This 
file is used for tag browsing when disconnected from a network.   



 

28 of 126 

4. To create a new shortcut, click the Add button in the Device Shortcuts area.   

 

5. Name the shortcut by typing ‘Intro’ and then pressing the Enter key on the keyboard.   

The Communication Setup dialog should now look like this:  

 

6. Expand the EtherNet, Ethernet driver by clicking the expander  once.   

 

7. Click the expander  once to open the 192.168.1.1, SoftLogix 5800 EtherNet/IP, SoftLogix 5800 
EtherNet/IP item.   
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8. Click the expander  to open the 1789-A17/A, 1789-A17/A Virtual Chassis item.   

 

9. Select 2, 1789-L60/A, BlockMachine by clicking on it once.  The dialog should now look like this:  

 

10. Click the Apply button above the Device Shortcuts pane to associate the SoftLogix 5800 Controller with the 
selected communication shortcut Intro.   

 

11. Click the Yes button to confirm the association.   
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12. Click the Close button to confirm the association.   

 

13. Close the Shortcut Verifier dialog by clicking the Close button.   
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Copying the Design Communication Configuration 

Typically, the Engineering Workstation on which the application is designed has a different path to the controller or device than 
the runtime terminal.  When this is the case, the Runtime configuration will be different than the Design configuration.   

In this lab, the design and production environments are identical.  To proceed, the Design communication configuration will be 
copied to the Runtime tab.  If you would like to manually configure the Runtime communication configuration, please go to 
Appendix A.   

1. Click the Copy from Design the Runtime  button to copy the 
communication configuration from the Design (Local) tab to the Runtime (Target) tab.   

2. When prompted, click Yes to confirm the operation.  

 

3. Click on the Runtime (Target) tab to select it.   

 

If necessary, use the expanders to open the topology items (e.g. drivers and devices) to confirm that the Design (Local) 
configuration have been replicated. 
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4. Click the Verify button to confirm the Design and Runtime associations.  

 

Confirm both the Design and Runtime devices are assigned to shortcut Intro.   

5. Close the Shortcut Verifier dialog by clicking the Close button.   

6. Click the OK button to complete the communication setup and close the Communication Setup dialog.   

 

Be sure to use the OK button!  If you close the dialog with the X, the communication setup with not be saved 
to the application.   
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Adding ‘Live’ Objects to a Display 

Now that a communication path to a controller is configured, objects (buttons, numeric displays, etc.) can be added to the display 
that will use information from the controller.  The lab uses a variety of different buttons, data displays, and images to illustrate 
FactoryTalk® View Machine Edition functionality and application capabilities.   

1. Double-click the MAIN display in the Explorer to open the display.  

 

2. Select the Maintained Pushbutton tool  from the Objects toolbar, or select Objects>Push 
Button>Maintained.   

 

3. Click and hold the left mouse button, then drag down and to the right to create a Maintained Pushbutton object 
in the middle of the display.   
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4. In the Properties box that appears, click the Common tab.   

 

5. Change the Height and Width fields to size the Maintained Pushbutton exactly.   

 Height – 120 

 Width – 150  

 

6. Click the Apply  button to commit these changes.   

The button should resize on the display to match these settings.   

7. Click the States tab.  
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States are explicit events that occur when the value of the tag connected to the object equals the value 
defined for the state.  If the tag value does not match any of those configured, the object will show the Error 
state.   

Simple pushbuttons have three states, each of which have default values, though these values can be 
changed by the user.   

Two complex objects, the multistate pushbutton and multistate indicator, allow a user to configure multiple 
states for the objects.   

8. Select State0 in the Select state: field.  

 

9. Enter ‘Start Pelleter’ in the Caption field.   
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10. Click the Bold button.  

 

11. Click the Back color square and select Black.   

 

Adding Images from Symbol Factory 

FactoryTalk® View Studio for Machine Edition version 6.0 and later includes Symbol Factory from Software Toolbox.  This library 
contains over 5000 images, most of which are vector graphics.  Vector graphics found in the library can be animated using any 
standard FactoryTalk® View Studio animation option.  The remaining bitmap images can be used as pre-existing objects to 
enhance applications.   

The following steps will walk through the addition of an image from Symbol Factory as the labels of both states of this object.   

1. Click the Image browser.   

 

2. Click the Launch Library button to bring up the Symbol Factory library.   
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There are three areas of the Library that will be used:  

Preview – A window where a larger version of the selected image can be viewed 

Categories – Images in the library are grouped in each of the categories in this list 

Symbols – Images that can be copied into the application 

3. Select the Gadget Buttons 2 category.   

Scroll down to find this category.   
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4. Scroll to the bottom of the Symbols window, and select the Illuminated rectangular pushbutton (Green Up 
Off) button image.   

 

5. Click Copy to copy the image to the project image library.   

 

6. Click Paste from Library to add the image to the project library.   
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7. Leave the default name and click OK.   

 

8. Click OK again to apply the image to State0.   

 

9. The State0 button properties should now look like this.   
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10. Select State1 in the Select state: field.   

 

11. Click the Back color square and select Black.   

 

12. Click the Caption color square and select Black.   

 

13. Enter ‘Stop Pelleter’ in the Caption field.   

 

14. Click the Bold button.   

 



 

41 of 126 

15. Click the Image browser button.   

 

16. Click the Launch Library button to bring up the Symbol Factory library.   

 

17. Select the Gadget Buttons 2 category.   

The library should retain the previous category, so this step can be skipped.   

 



 

42 of 126 

18. Select the Illuminated rectangular pushbutton (Green Down On) button image.   

 

19. Click Copy to copy the image to the project image library.   

 

20. Click Paste from Library to add the image to the project library.  
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21. Leave the default name and click OK.   

 

22. Click OK again to apply the image to State1.   

 

23. The State1 button properties should now look like this.   
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24. Click the Apply  button to commit these changes.   

Note that the button will now show the state that is currently selected.   

25. Close Symbol Factory, by right clicking the icon in the task bar, and selecting Close window.   

 

26. Click the Connections tab.   

 

27.  In the Value row, click on the Browse button in the Tag column.   

 

This action opens the Tag Browser.   
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The Tag Browser is used to view and select tags from the device selected in the RSLinx Enterprise setup 
earlier in the lab.   

Sections of the Tag Browser 

Three portions of the tag browser should be noted:  

Folders – Used to browse a shortcut’s Controller and Program tags, as well as User Defined Tags 

Tags – Used to select a specific tag from the selected folder 

Tag Filter – Shows only those tags that start with the filter entered by the user.  Pressing Enter will apply the 
filter to the tag area.   

28. Right-click on the Intro item in the Folders list; select the Refresh All Folders item.   

 

Alternatively, you can use the Refresh All Folders button, located near the bottom of the Tag Browser:  

 

29. Double click the Intro folder, then double click the Online folders to expand them.  

 



 

46 of 126 

30. Scroll down, then select the Program:Extruder_Control item.   

 

31. In the Tag Area, locate and select the tag Pelleter_Running.   

The Name column of the tags area may need to be resized in order to read the full tag name.   

 

Note that the Selected Tag text box reflects your selection.   
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32. Click OK to complete the Connection configuration.   

 

Notice the Value connection has been updated with the path to the tag specified using the tag browser.   

33. Click OK again to close the property dialog.   

The button has now been updated with all the changes made in the property dialog.   

 

Note: The screen will display the last State selected in the Properties Dialog.  Therefore, your MAIN scren may look different 
than the picture above.   

34. Select the Numeric Display tool  from the Objects toolbar, or select Objects>Numeric and String> 
Numeric Display.   

 

35. Draw the Numeric Display above the pushbutton by clicking and holding the left mouse button, then drag down 
and to the right to create the object:  
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36. Change the following properties:  

 Border Style – Inset 

 Text – Bold  

 Back color – Light Gray (click on the color square to open the color pallet) 

 Fore color – Black (click on the color square to open the color pallet) 

 

37. Click the Common tab.  

38. Change the Height and Width fields to size the Numeric Display exactly.   

 Height: 50 

 Width: 100 

 

39. Click the Connections tab.  
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40. In the Value row, click the Browse button in the Tag column to open the Tag Browser.   

 

41.  In the Folder pane, expand the path Intro > Online > Program:Extruder_Control.   

 

42. Select Peleter_Speed.   
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43. Click OK to complete the connection configuration, and OK again to close the properties dialog for the Numeric 
Display.   

 

44. Save the MAIN display using the File>Save menu item.   

 

45. Close the MAIN display.     
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Testing an application on the Desktop 

Testing an application can be performed by downloading and running it on a PanelView™ Plus terminal.  However, to save time, 
it is possible to test the full application on the Desktop.  This can be done using the emulation capability included in FactoryTalk® 
View Studio for Machine Edition.  The following steps will walk through testing the application on the Desktop.   

1. From the Application menu, select the Test Application item.   

The system will build the runtime MER.    

 

When the runtime MER file is built, the system loads the runtime MER into an emulation mode.  The application will appear 
in the upper left-hand corner of the computer monitor.   

 

2. To test the objects that have been created, click on the Start Pelleter   button.   

The color is now an illuminated green, and the caption reads Stop Pelleter.  The numeric display is showing a value other 
than 0.   
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3. Click the Stop Pelleter   button to end the simulated process.   

4. Click the Shutdown button to end the emulation.   

Congratulations!  

You have successfully modified your application by configuring communications with a controller, adding ‘live’ content, 
created a test application, and emulated the application on your desktop.   
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Adding Alarms to an Application 

Completing this section requires approximately 20 minutes.   

Making irregular system or process events visible to operators is a critical component of many HMI applications.  FactoryTalk® 
View Machine Edition provides an intrinsic alarming function that can be used for this purpose.  This section will cover:  

 Alarm basics 

 Configuring alarms for the Intro application 

The following provides an overview of how alarms will be created in this lab section:   

 

 

1 Create several alarms for the application.   

2 Use the default Alarm display to announce and exercise the alarm function.   

 

Start by adding some preconfigured components to the application.  These components have been configured in advance in 
order to save time during this lab session, and include screens and images that will provide the ability to simulate Alarms during 
runtime.   
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1. In the Explorer pane, under Graphics, right click on Images, and select Add Component Into Application… 

 

2. Browse to C:\Lab Files\View ME – Introductory\ViewME\Images folder.  

 

3. Select all the images by pressing the Ctrl and A keys on your keyboard, and click Open.   

 

The images will be brought into the HMI project.  

 

The images that have just been added to the application are of the Bitmap format.  Now, add 5 PNG files that will be used 
later.   
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4. In the Explorer pane, under Graphics, right click on Images, and select Add Component Into Application… 

 

Note that the browser window retains the previous location.   

 

5. Use the drop down list to select PNG Images (*.png).   

 

Using this filter makes the browser show the five png files found in this folder.   
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6. Select all of the png files using Ctrl and A on the keyboard, and select Open.   

 

These five images will now import into the application.   

7. Right click on Displays and select Add Component Into Application.   

 

8. Browse to C:\Lab Files\View ME – Introductory\ViewME\Displays folder.  
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9. Select the ALARM_GENERATOR.gfx and Preconfigured_Buttons.gfx files and click Open.   

 

Creating HMI Tags 

HMI tags are created within the FactoryTalk® View Studio environment, and are not contained within the device specified in the 
RSLinx Enterprise Communication setup.  These tags, during runtime, are stored on the Machine Edition Station terminal or 
computer.  This section will cover creating and using HMI tags to simulate alarm functionality.   

1. Right click on Tags and select Open to open the HMI tag database.   

 

2. Enter the following (items 1-5) to create the first tag, Alarm_Analog1, and click Accept.   
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3. Click Next, and enter the following to create the second tag Alarm_Analog2.  Click Accept.   

 

4. Click Next and enter the following to create a digital tag, Alarm_Digital1.  Click Accept.   

 

5. Click Next and enter the following to create the final tag, Trip_Point.  Click Accept.   

 

Note the Initial Value of 65 – this value will appear later in the Alarm section.     
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The HMI database should look similar to the picture below:  

 

6. Close the HMI tag database editor.   

Configuring Alarms using the Alarm Setup 

1. Right click on Alarm Setup and select Open.   

 

Alternatively, the Alarm Setup dialog can be opened by double clicking Alarm Setup.   
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Understanding Alarm Setup 

The native Alarm system within FactoryTalk® View Machine Edition is a powerful tool available to every 
application.  This system allows the operator to react and respond to irregular application events (e.g., motor 
overload, high level conditions, etc.).  The alarm system can be configured to be entirely self-contained to the 
application at runtime, or it can be configured to coordinate and communicate with the control system.   

Triggers 

A designer will use this tab to define and manage the events that trigger an alarm to occur.   

 

Messages 

For each defined alarm event, the designer can configure the message that corresponds to that alarm – the 
text of the message, as well as the look of the message.   
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Advanced 

The HMI designer can specify the display used when an alarm is triggered, as well as other advanced 
settings, such as the size of the alarm log and any optional tag connections needed.   

 

2. Click Add… to assign Alarm Triggers.  
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3. Click the Exprn button to open the Expression editor – the first trigger will use a short expression.   

 

4. Click the Tags… button.   

 

5. Select the appropriate tag using the steps below:  

1) Click the Intro root 

2) Select Alarm_Analog1 

3) Click OK 
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6. Click Relational… and select the Greater Than symbol.   

 

7. Type ‘200’ after the > symbol and click OK.   

 

8. Click OK again to assign the expression to the Alarm Triggers list.   

 

9. Click Add… to create another Alarm trigger.   

10. Click the Exprn button to launch the expression editor.  

 



 

65 of 126 

11. Copy and Paste the following expression into the expression editor.   

If {Alarm_Analog2} > 65 Then 65 Else 0 

 

Fell free to use the Check Syntax button to verify that the expression has been entered correctly.   

12. Click OK twice to assign the expression to the Alarm Triggers list.   

The alarm is now in the trigger list.   

 

13. Click Add… to create the last Alarm Trigger.   

14. This time, click the Tag browser button.  

 

15. Select Alarm_Digital1, and click OK twice to select the tag and assign it to the trigger.     
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The Select trigger list should look like the following:  

 

16. Click the Messages tab to assign trigger values and messages to the alarm triggers you created.   

 

17. Click the Trigger drop down list, and select {Alarm_Analog1} > 200  to assign the first trigger.    

 

18. Enter ‘1’ in the Trigger value field.  

 

19. Type ‘Tank Level  > High Alarm’ in the Message field.  
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20. Leave the rest of the settings at their default values.  

 

21. Use the Trigger menu to select the If {Alarm_Analog2} > 65 trigger.     

 

22. Enter ‘65’ in the Trigger value field.   

 

23. Type ‘Temperature higher than 65C’ in the Message field.   

 

24. Again, leave the rest of the settings at the default values.   
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25. Use the Trigger menu to select the Alarm_Digital1 trigger.   

 

26. Enter ‘1’ in the Trigger value field.   

 

27. Type ‘Digital1 Alarm triggered by user’ in the Message field.   

 

28. Again, leave the remaining settings at their default values.  

29. Click OK to apply the Alarm Setup settings.   

30. Double click the MAIN display to open it.   
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31. Double click the Preconfigured_Buttons display to open it.   

 

The Preconfigured_Buttons display contains several buttons that have already been configured for you.  The buttons, 
when pasted into other displays, will paste to the same location as they appear on the Preconfigured_Buttons display, 
since their size and location properties are retained.   

 

32. Select the Alarm Generator  button and copy it by right clicking and selecting Copy or use Crtl+C on 
your keyboard.   

33. Minimize the Preconfigured_Buttons display, and paste the button onto the MAIN display by pressing Ctrl+V 
on your keybarod.   
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Your MAIN display should now look similar.   

 

The button you pasted is a Goto Display pushbutton that is configured to open the ALARM_GENERATOR display that has 
a bitmap image assigned to it (Icon-Alarm).   
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34. Close the MAIN display and save the changes when prompted.   

35. Close the Preconfigured_Buttons display and click No when prompted to save changes.   

Testing the Alarms  

1. Test the application on the Desktop by selecting the Running man  icon in the toolbar.   

Note that screen that opens may not match exactly the picture below.   

 

2. Click the Alarm Generator button  to open the Alarm Generator display.   
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3. Click the Red  pushbutton to simulate a digital alarm.  Notice that the Alarm banner opens.   

 

This example is using the digital alarm that was configured previously.  When the momentary button is pushed, the 
Alarm_Digital1 tag value changes from 0 to 1 which causes the alarm to trigger.   

4. Click the  button to close the Alarm banner.   

5. Click the Red pushbutton to reset the alarm.   

6. Click the Up arrow repeatedly until a value greater than 200 is displayed (approximately 9 times).   

Each press of the Ramp button increments the value by 25.   

 

 

The example uses an expression for the alarm trigger.  When the tag reaches a value greater than 200, the expression is 
evaluated as true, and its value is 1.   
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7. Click the  button to close the Alarm banner.    

8. Click the Down arrow repeatedly until a value below 200 is reached.   

9. Click your mouse onto the slider and leave it clicked while you move the slider up past the Alarm Trip Point.   

 

Make sure to move the slider above the Alarm Trip Pt on the screen.   

This alarm also uses an expression – once the value of the tag is greater than 65, the alarm will trigger, and the Alarm 
Banner will open.   

 

10. Click the  button to close the Alarm Banner, and move the slider down below the Alarm Trip Point.   

11. Push the X key on your keyboard to shut down the application.   
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Alarm History Display 

The previous section explored how Alarms are set up, as well as how the Alarm Banner can alert a user when these alarms 
occur.  It is also possible to maintain and display a history of alarms.  FactoryTalk® View Studio for Machine Edition includes 
completed Alarm History graphic displays that can be added to an HMI project.  These graphic displays can be found under the 
Libraries container in the Project Explorer pane.   

 

For this application, a new display with an Alarm List will be created.   

1. Right click on Displays and select New.   

 

2. Now, select Objects > Advanced > Alarm > Alarm List.   
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3. Using the left click button, draw a rectangle on the new display, starting in the upper left corner, and extending 
about three-quarters of the way down.   

 

The Alarm List Properties configuration dialog will open automatically.  

4. Select the Alarm tab.   

 

5. Uncheck the Display column for the following items by selecting each one, then clicking the Display Column 
box:  

 Acknowledged symbol 

 Active symbol 

 Acknowledge time 

 

For this application, we only want to display the Alarm time and Message on the Alarm List.  

6. Click OK to apply the changes and close the properties dialog.   
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7. Save the display by clicking the  icon on the toolbar.   

8. Enter ‘Alarm History’ for the display name, and click OK.   

 

Next, buttons that will be used to navigate to and select alarms, as well as navigate to other displays, will be added to this 
screen.  

9. Go to Objects, then select Advanced > Alarm > Clear Alarm History.   

 

10. Using the left click button, draw a rectangle in the lower left corner of the display.   

 

The Clear Alarm History button properties configuration dialog pops up.  

11. Select the Label tab.   
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12. Enter the caption shown below, then click OK.   

 

The button should look similar to what is showing.   

 

13. Go to Objects and select Key > Move Up.   

 

14. Using the left click button, draw a small square next to the Clear History button.   

 

The Move Up button properties configuration dialog will open.  
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15. On the General tab, use the Send press to: drop down menu to select Linked Object.   

 

16. Click the browser button for Linked object to bring up a list of objects to assign the button press to.   

 

17. Select AlarmList1 and click OK.  

 

18. Click OK again to apply the changes to the Move up button.  

19. Perform steps 13-18 to add a Move Down button to the display.  

The buttons should now look similar to the following:  

 

20. Double click the Preconfigured Buttons display to open it.  
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21. Copy the Return  button by selecting it, then pressing Ctrl and C on the keyboard.    

22. Minimize the Preconfigured Buttons display and paste the button onto the Alarm History display.   

Your display should look similar to what is shown below:  

 

23. Close the Alarm History display and save your changes when prompted.   

Next, a button will be added to the MAIN display to navigate to the Alarm History display.   

24. Double click the MAIN display in the Project Explorer pane to open it.   
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25. Restore the Preconfigured Buttons display and copy the Alarm History  button.   

26. Close the Preconfigured Buttons display (do not save any changes) and paste the Alarm History button onto 
the MAIN display.   

The MAIN display should now look similar to what is shown below:  

 

The Goto display button just added is assigned to the Alarm History display.   
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27. Close the MAIN display and save the changes when prompted.   

Testing the Alarm History Screen 

1. Test the application on the Desktop by selecting the Running man  icon on the toolbar.   

2. Generate some alarms, then navigate to the Alarm History screen by clicking the Alarm History Goto Display 

 button.   

Refer to the previous section for instructions regarding generating the alarms.   

Notice how the alarms appear in the list.  The Alarms that are in the Alarm List object are also saved to an alarm log (also 
called the alarm history).  This log can store up to 10,000 alarms.  The alarm history size is defined in the Alarm Setup 
under the Advanced tab.  The default log size is 128 messages.   

 

Pressing the Clear History button will clear all alarms stored in the alarm log file.   

3. Shut down the test application by pressing the letter X on your keyboard.   

Congratulations!  You have successfully configured alarms for a FactoryTalk® View Studio for Machine Edition application.   
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Using Global Objects to Make Application Design Convenient and Quick 

This section of the lab will describe and demonstrate FactoryTalk® View Machine Edition functionality that allows the reuse of 
objects as well as graphic displays.  Specifically, this section will cover the following:  

 Global Objects 

 Base Object 

 Reference Objects 

 Tag Placeholders 

 Global Object Parameters 

What is a Global Object?  

Global Objects are a component of FactoryTalk® View Machine Edition that can be created and configured once, then reused 
across the application.  Any change made to the original, base object will be reflected in the reference objects (copies of the 
base global object).  However, it is possible to break the link between the base object and reference objects for specific 
properties.   

What are Placeholders and Parameters?  

Placeholders provide a way to use one graphic display or global object to represent a number of similar operations.  In this lab, 
there will be multiple silos containing different material.  However, each of these silos should show similar types of information 
(level in the silo, temperature, etc.).  Instead of creating two unique sets of objects, a global object will be used with tag 
placeholders.   

A placeholder is a crosshatch character (#) followed by a number (from 1 to 500).  At runtime, this placeholder is replaced by all 
or part of a tag string.   

Parameter files or parameter lists are components within the application that specify what tag should replace each tag 
placeholder at runtime.   

In the section below, you will use one global object that will represent information from 4 silos.  Additionally, you will specify the 
placeholder and parameter information used for each reference object.   
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Creating Base Global Objects 

This lab will use a base object that has already been developed to save time.   

1. Right click the Global Objects folder in the Project Explorer and select Add Component Into Application… 

 

2. Browse to C:\Lab Files\View ME – Introductory\ViewME\Global Objects.   

 

3. Select Screen Objects.ggfx and click Open.   

 

4. Open the Screen Objects display that was just added under Global Objects.   

 

Explore this object to determine where tag placeholders are being used.   
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5. Click View in the toolbar, then select Object Explorer.   

 

The object on the Screen Objects global display is created of many grouped elements.  Using the Object Explorer will 
provide an easy way to select the individual components that make up the full global object.   

6. Expand Group7 and then Group13 by clicking the +.   

 

7. Right click on Polygon2 and select Animation, then Fill… 
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Notice the #1 within the tag string:  

 

This is a tag placeholder that has been assigned to this setting in the global object.  The placeholder will be replaced with 
the appropriate Silo number at runtime.   

8. Close the Animation configuration dialog.   

9. Using the Object Explorer, double click NumericDisplay5.   

 

10. Click the Connections tab.   

Notice that #1 is used in place of the silo number once again.   

 

The numeric display will show the value of the Lower Hopper Level at runtime for the appropriate silo.   
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11. Close the Numeric Display Properties  configuration dialog.   

12. Using the Object Explorer, double click MultistateIndicator4.   

 

13. Click the Connections tab, then click the Expression browser button.   

 

The #1 is again being used in place of the silo number.   

 

This expression sets the state value of the multistate indicator.  Three states have been configured that will be used to 
indicate the present state of the silo: Filling, Filled, and Emptying.   
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14. Close the Expression Editor and the Multistate Indicator Properties configuration dialog.   

15. Using the Object Explorer, open Text9.  

 

Notice the #1 in the Text field.   

 

This placeholder will be replaced by the Silo number at runtime.   

16. Close the Text Properties configuration dialog and the Object Explorer.   

Now, let’s assign the parameter definition for the Global Object.   

17. Right click on the global object, and select Global Object Parameter Definitions.   
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18. Enter ‘#1’ and ‘Silo Number’ as shown below, and click OK.   

 

This placeholder will be used for the full global object.  Now, when the global object is used on a display, its parameter can 
be specified.  In the next section, this functionality will be explored.   

19. Close the Screen Objects display, and save the changes when prompted to do so.   

Using Reference Objects and Parameters 

Two screens on which the global object will be used have been created in advance, and must be added to this application.   

1. Right click on Displays and select Add Component Into Application…  

 

2. Browse to C:\LabFiles\View ME – Introductory\ViewME\Displays folder 
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3. Select the Vacuum Silo Group.gfx and Vacuum Silo.gfx files, and click Open.  

 

4. Open the Screen Objects Global Display,  

 

5. Copy the Silo global object by right-clicking the object and selecting Copy.   
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6. Open the Vacuum Silo Group display.   

 

7. Right click anywhere on the display, and select Paste.  

 

8. Click and drag the new object to the lower left area of the screen.   
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9. Copy and paste the Silo object three more times, until there are 4 copies of it on the display.   

 

Now the parameter value for the #1 place holder will be assigned.   

10. Right click the first global object, and select Global Object Parameter Values.   

 

11. Enter ‘1’ for the Value property, and click OK.   
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Remember the #1 placeholder that was configured in the global object.  At runtime, the placeholder will be replaced with the 
number 1.   

Use the steps below to assign the parameter values for the remaining objects.   

12. Repeat steps 10 and 11 for the remaining objects, entering ‘2’, ‘3’ and ‘4’ respectively.   

Each of the reference objects will now use values 1, 2, 3, and 4 to replace the placeholder #1 at runtime.   

Reusing Displays with Parameters 

Global Objects, placeholders and parameters are a way to reuse objects across screens in an application.  The following steps 
will explore how to reuse screens in an application using parameters.   

1. Open the Vacuum Silo display.  

 

 

This display will be reused to show data for each of the silos.  In this case, the placeholder #1 is used to represent the Silo 
number.  However, the value for this placeholder is provided using the parameter list.   
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2. Click View in the toolbar, then select Object Explorer.   

 

3. Using the Object Explorer, open MultistateIndicator1.   

 

4. Click on the Connections tab.   

 

Notice that #1 is in place of the Silo number.  This placeholder will be replaced by the silo number at runtime.   

5. Close the Multistate Indicator Properties configuration dialog and the Object Explorer.   

6. Close the Vacuum Silo display.  Do not save any changes.  

7. On the Vacuum Silo Group display, double click one of the Silos in the middle of the tank.   
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The properties dialog for a Goto Display button will open.   

 

In this example, the first Silo was double clicked.  Notice that the Display called is the Vacuum Silo display.  The 
Parameter list has also been configured, sending the value of 1 to the placeholder used within the Vacuum Silo display.  If 
more than one placeholder had been used on the Vacuum Silo display, replacement values should be configured in the 
Parameter list, separated by commas, in order.  For example, if the parameter list is {X}, {Y}, and {Z}, X is sent to #1, Y to 
#2, and Z to #3.   

8. Close the Goto Display Button Properties window.   

9. Close the Vacuum Silo Group display, and save the changes when prompted.   

10. Close the Screen Objects Global Display.  Do not save any changes if prompted.   

Using Cross Reference and Search and Replace Functionality 

Sometimes preconfigured displays that are added to an application contain references to shortcuts that are not being used in the 
application.  This section will explore how often the old shortcut name, BlockComms, is being used, and will then replace that 
shortcut with the one being used in this application.   

1. Click on the Cross Reference icon in the toolbar.  
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2. Type ‘BlockComms’ in the Find what: box, then click Search.   

 

When the Cross Reference is complete, the window will update with the number of components that contain BlockComms.  
It is now possible to find out exactly where a specific tag or shortcut is used in an application.   

 

In this example, 10 components were found.  Double clicking any of these items will take the user to the specific 
component.  It is now possible to access that tag and manually change the tag name.  However, some of the components 
use expressions, in which the term BlockComms is used multiple times.   

Use the Search and Replace functionality to make these changes.   

3. Close the Cross Reference dialog.   

4. Click on the Replace icon.   
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5. Enter ‘BlockComms’ into the Find what: box, and ‘Intro’ into the Replace with: box.   

 

6. Click the Replace All button.   

 

7. Click Yes to confirm the replacement.   
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When the process is complete, a list of successful or failed attempts will be shown.   

 

8. Close the Find and Replace dialog.   

Now a Goto display button must be added to the Main screen in order to navigate to the Vacuum Silo Group display.   

9. Open the MAIN display.  

 

10. Open the Preconfigured Buttons display.  

 

11. Copy the Vacuum Silo  button.   

12. Close the Preconfigured Buttons display and paste the Vacuum Silo button onto the MAIN display.   

Remember, the button will paste into the desired location on the screen.  
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13. Close the MAIN display and save the changes when prompted.   

Testing Global Objects and Parameters 

1. Test the application on the Desktop by selecting the Test Application  icon on the toolbar.   

2. Click the Vacuum Silo  button.   

The data and states of the 4 silos are shown using one global object.  Notice the mustard yellow color when the state of the 
Silo is Filling.   

 

3. Click on the center of all 4 silo tanks  to navigate to the Vacuum Silo display, using the Return 

 button to navigate back.   

 

Notice how the Vacuum Silo display changes the values/colors shown depending on the tank that was selected.   

4. Click the X key on your keyboard to shut down the test application.   

Explore the Link between Base and Reference Global Objects 

Now, let’s change the background color of the multistate indicator for all 4 silo data objects.   

1. Open the Screen Objects global objects display.  
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2. Click View in the toolbar, and select Object Explorer.   

 

3. Using the Object Explorer, open MultistateIndicator4.   

 

4. Click the States tab, and select State1.   

 

5. Click the square next to Back color to bring up the color palette.   
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6. Select a shade of light green, and click OK to apply the change and close the Properties dialog.   

 

7. Close the Screen Objects display, and save the changes when prompted.   

8. Test the application on the Desktop by selecting the Running Man  icon on the toolbar.   

9. Click the Vacuum Silo   button.   

 

Notice that the background color of the Filling state of all 4 Silos is now a light green color.  A few minutes may need to 
pass for all 4 silos to enter the Filling state at least once – they do not go into a specific state at the same time.   

10. Click X on your keyboard to shut down the test application.   

You have now learned about Global Objects, placeholders, parameters, and reusing screens, and how each of these things 
can reduce the time to design your application.     
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Language Switching 

The FactoryTalk® View Machine Edition Language Switching functionality makes it possible to create a single application that 
can be used in multiple locations.  For the lab, this application will be modified so that it can be used in China, Germany, Italy 
and Spain, as well as the United States.   

Adding Languages and Translating Strings 

1. Select Tools > Languages… from the toolbar.  

 

2. Click Add… to open the list of languages that can be added to the application.   

 

3. Add the following languages to the application, by selecting the language, then clicking OK.   

Note that each language must be added one at a time.   
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The Language Configuration dialog should appear as shown:  

 

4. Click the Apply button to add the languages to the application.  

5. Ensure English is checked and that Display undefined strings using the default language is checked.  Click 
the Export button.   

Now, all of the strings in the application will be exported in order to ease the translation process.   

6. Ensure the settings are selected as shown below, and click Next.   
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7. Click Finish to begin the export process.   

 

8. If the Excel window does not open automatically, click on the Microsoft Excel icon in the Windows taskbar.   

 

Notice the column headings and how the languages are shown.  Any text that is not translated is shown as 
**UNDEFINED**.   

 

 

New strings for each language can be translated manually.  Alternatively, the FactoryTalk® View Translation Utility can be 
used.  This utility uses Microsoft’s Bing Translator.  In this lab, the strings for two objects on the MAIN display will be 
translated manually.   
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9. Open Windows Explorer by clicking the folder  in the Task Bar.   

10. Browse to C:\Lab Files\View ME – Introductory\ViewME\Strings.   

 

11. Double click Translated Strings.docx.   

12. Copy the text for each language that was added from the Word document into the appropriate cell of the 
exported Microsoft Excel file, replacing the **UNDEFINED** text.   
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13. When finished, close and save the Microsoft Excel file.   

14. Close the Microsoft Word document.   

15. On the Language Configuration dialog, click the Import button.  

 

16. Select Import strings from an Excel spreadsheet into all application languages defined in the 
spreadsheet, and click Next.  
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17. Click the Browse button.   

 

18. Select Intro_1.xls and click Open.   

 

Note that the default path for this Excel file is C:\Users\Public\Documents\RSView Enterprise\Strings.   



 

107 of 126 

19. Click Finish to begin the import process.   

 

20. Once the import is complete, click OK to exit the Language Configuration dialog.   

Adding Language Switch Buttons 

Specialized Language Switch pushbuttons have been built into FactoryTalk® View Studio in order to make it easier for users to 
alternate between languages during runtime.  These buttons are simple to add and configure for each language used in the 
application.  A total of 5 languages have been configured in this application, so 5 Language Switch pushbuttons need to be 
added as well.   

1. Open the MAIN display.   
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2. Click Objects > Advanced > Language Switch Button.   

 

3. Add the button to the lower left corner of the MAIN display, by holding down the mouse’s left button and drawing 
a square.   

4. Leave the Language configured for English.   
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5. Change the following settings:  

1) Border style: Line 

2) Border width: 1 

3) Back style: Transparent 

4) Back color: black 

 

6. Click the Label tab, and click the Image browser button.   

 

7. Select the Flag_United_States image.   

 

Note the format of this image is PNG.  When FactoryTalk® View Machine Edition version 7.0 released, it 
included the ability to utilize the PNG image format.  A PNG image is a high quality, high resolution file, and 
supports transparency.  Additionally, a PNG file will not decrease in sharpness when resized.   
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8. Click OK, then click Apply to apply the changes.   

9. Click the Common tab, and enter the values shown below for Size and Position, then click OK.   

 

10. Click OK to apply the changes and close the Properties dialog box.   

The MAIN display should now look similar to the one below:  

 

Language Switch buttons are needed for the remaining languages configured for this application.  They have been created 
and reside in the Preconfigured Buttons display.  

11. Open the Preconfigured Buttons display.   
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12. Copy the 4 Language Switch buttons.  

 

13. Close the Preconfigured Buttons display and paste the buttons onto the MAIN display.   

Remember, the buttons will paste in the desired location.   

 

14. Close the MAIN display, and save the changes when prompted.   

Testing the Language Switch Application on the Terminal 

Remember, to test the application on the physical PanelView™ Plus terminal, a runtime file (.MER) must be created and 
downloaded to the terminal.   

1. Select Create Runtime Application from the Application menu.   

 

2. Confirm the following information on the Create Runtime Application dialog:  

 File name: Intro.mer 

 Save type: Runtime 8.0 Application (*.mer) 

3. Click the Save button to begin runtime application creation.  

4. If prompted, click the Yes button to replace the existing runtime application.   
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5. Select all the languages to include in the runtime file, and click Finish.   

 

After a few moments, a progress dialog will appear.   

 

This dialog will close when the application has been created.   

6. To download the MER to the terminal at your workstation, select Tools > Transfer Utility.   

 

The Transfer Utility will open.   
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7. Verify the Source file field contains the following: C:\Users\Public\Documents\RSView 
Enterprise\ME\Runtime\Intro.mer.   

If it does not, browse to the file using the ellipsis button.   

 

8. Select 192.168.1.20, PanelView Plus_7 Performance 1200W in the Select destination terminal: tree.   

 

9. Click the Download button.  If prompted to overwrite the existing file, click Yes.   

During the download, a progress dialog will update.   

10. Click OK to acknowledge the dialog that the download completed successfully 

.  

11. Click the Exit button to close the Transfer Utility.   
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Running the Application 

Use the PanelView™ Plus to run the downloaded runtime application.  If FactoryTalk® View ME Station is not open, double-tap 
the desktop icon to open it.   

1. Press the Load Application [F1] button.  

 

2. Select Intro.MER from those available in the terminal’s Internal Storage.  

 

3. Press Load [F2] to load the runtime file into memory.   

4. When prompted, press Yes [F7] to overwrite the terminal’s current communication configuration with the 
configuration contained within the Intro.mer file.   
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5. Once it has successfully loaded, press the Run Application [F2] to start the runtime file.   

 

After the start-up process is complete, you should see the startup display.  

 

6. Click the Language Switch buttons and notice how the text changes for the 2 objects that were translated on the 
MAIN display.   

7. When finished, press the Shutdown 

Congratulations!   

You have successfully added languages to the application, translated the text strings of two objects, and added Language 
Switch pushbuttons.   
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Appendix A – Manually Configuring Runtime Communications Path 

1. Click on the Runtime (Target) tab  to select it. 

2. Right-click on EtherNet, Ethernet item to open the context menu, and select Add Device. 

  

3. Click Add Device which opens the Add Device Selection dialog. 

4. Expand the EtherNetIP Devices item by clicking the expander . 

5. Select the expander  next to SoftLogix 5800 EtherNet/IP. 

6. Select SoftLogix 5800 EtherNet/IP, Major Revision 21. 
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7. Click the OK button  to accept the selection.  This action opens the Device Properties dialog. 

 

8. Enter ‘192.168.1.1’ in the Address field to set the device’s TCP/IP address. 

9. Change the selected Slot to 3. 

 

10. Click the OK button  to add the device to the Runtime (Target) configuration. 
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11. Use the expander to open the 192.168.1.1, SoftLogix5800 EtherNet/IP, SoftLogix 5800 EtherNet/IP device. 

12. Right-click the 1789-A17, 1789-A17 Virtual Chassis item and select Add Device. 

 

13 Expand the 1789-L60/A, 1789-L60/A SoftLogix 5860 Controller item by clicking. 

 

14. Select the 1789-L60/A SoftLogix 5860 Controller, Major Revision 21 item. 

  

It is important that you select the correct 
Major Revision for the SoftLogix 5860 
Controller. 

The correct revision is Major Revision 21. 
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15. Click the OK button  to accept the selection. 

16. Change the controller’s Slot property to 2. 

 

17. Click the OK button  to add the device to the Runtime (Target) configuration. 

 

18. Click the Apply button  in the Device Shortcuts pane. 

19. Click the Yes button  to apply the changes to the Intro shortcut. 
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20. Click the Verify button  to confirm the Design and Runtime associations. 

 

Confirm both the Design and Runtime devices are assigned for shortcut Intro. 

21. Close the Shortcut Verifier dialog by clicking the Close button . 
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Lab Configuration and Setup 

Lab Information 
    

Lab Name FactoryTalk® View Machine Edition and PanelView™ Plus Introductory Lab 

Lab Description 

This hands-on lab focuses on basic FactoryTalk® View Machine Edition 
concepts for new users. Topics include creating an application; working with 
displays; global objects, and tags; using parameters; testing and running the 
application; and language switching. 

Lab Creator Wil Mattheis 
Date Created 02/04/2015 
Updates:    

  

Hardware Configuration per Student 

Qty Demo Cat.# / Description Communication Location Firmware 

1 Computer workstation consisting of       

1 2 GHz CPU 

1 4 GB RAM 

1 
Hard drive.  Minimum 40GB 

capacity 

1 USB Keyboard 

1 USB Mouse 

1 
Ethernet adapter.   Configured for 

DHCP

1 

Ethernet adapter.   IP Address: 
192.168.1.1, 

Subnet: 
255.255.255.0 

1 
Video adapter.  Minimum 

resolution: 1260 x 1024 pixels 

1 
LCD Display.  Minimum resolution: 

1260 x 1024 pixels 

1 

Ethernet CAT5E cable 5ft 
(PanelView™ Plus terminal to 
SoftLogix Ethernet adapter) 

1 
 

PanelView™ Plus 7 Performance 
12” W 

IP Address: 
192.168.1.20, 

Subnet 
255.255.255.0 

8.00.XX or later 
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Computer/Host Settings 

 

 

 

 

 

 

Location Files 
Computer Name Varies by machine 

IP Address (NIC 1) DHCP – connected to Event classroom network 

IP Address (NIC 2) Host computer TCP/IP setting: DHCP 
VMware image TCP/IP setting:  

IP Addr: 192.168.1.1 
Subnet: 255.255.255.0 

Operating System Windows 7 Professional 
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Basic Setup Diagram 

To Classroom network
DHCP assigned IP

Student Station

PanelView Plus 6 1250

CAT5E cross-over 
cable

Tank
02
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F12
12 102 31

High level Tank 02
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Waste
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Temp.:
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123 gr
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OFF
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Temp.:
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Level:

123deg

12Pa

4,5m

PLANT J45

Output:

Tank 01

Tank 02

Tank 03

Tank 04
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React. A

React. B

React.  C

React.  D

React. E

Level H234

Start/Stop

Auto

Manual

Force

Setpoint

Output

345

34

LL L H HH

NIC 2
Host computer TCP/IP setting:    DHCP 
VMWare image TCP/IP setting:   IP Addr 192.168.1.1

Subnet 255.255.255.0

IP Addr: 192.168.1.20
Subnet: 255.255.255.0

CAT5E cable

NIC 1
Host computer TCP/IP setting: DHCP 

 

Application/Programming 
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RSLinx - DDE/OPC Topic Configuration 
Topic Name Path to Hardware 

N/A 

RSLinx - Driver Configuration 
Topic Name Path to Hardware 

AB_VBP-1 (no 
topic required) 

Virtual backplane driver to be able to download the acd file to the SoftLogix 
v21 controller in slot 2 (if running this lab independent of the VM Image 
 

RSLinx Enterprise - Shortcut Configuration 
Shortcut 

Name Path to Hardware 

Intro Ethernet, Ethernet > 192.168.1.1 > Backplane > 2, 1789-L60 v21 
  

Location Files 
C:\Lab Files\ViewME – View ME -  
Introductory \PVP None required. 
C:\Lab Files\ViewME – View ME -  
Introductory \SoftLogix Block_Machine.acd (Slot 2) 

C:\Lab Files\ViewME – View ME -  
Introductory \ViewME 

Translated Word doc for languages & prebuilt 
displays and graphics for a PVP7 Performance 
12" W terminal size 

Additional Equipment Required per Workstation 
Qty Items 

1 Ethernet CAT5E cable 5ft (used with PanelView™ Plus terminal) 

1 Ethernet CAT5E cable 5ft (used with Event classroom network) 

1 PanelView™ Plus 7 Performance 12’W  
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Application Versions 
Vendor Software Version Service Pack 

Rockwell 

FactoryTalk® 
Activation 
Manager 

3.62.11 CPR9 SR6.1 

Rockwell 
FactoryTalk® 
Diagnostics 

2.71.00 CPR9 SR7.1 

Rockwell 
FactoryTalk® 
Service Platform 

2.71.00 CPR9 SR7.1 

Rockwell 
FactoryTalk® View 
Machine Edition  

8.00.00 CPR9 SR7 

Rockwell RSLinx Enterprise 5.70.00 CPR9 SR7 

Rockwell RSLinx Classic 3.71.00 CPR9 SR7.1 

Rockwell Studio 5000 21.00.00 CPR9 SR5.1 

Rockwell SoftLogix 5800 21.00.00 CPR9 SR5.1 

Rockwell .NET Framework 4 

Microsoft Internet Explorer 10   

Rockwell 
PanelView™ Plus 
7 Performance 

8.00.xx 
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